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Chapter 1

About AppsAudit

AppsAudit tracks changes to the values of fields in database tables, and displays
reports that present information about changes to each field. For each database row
in which field values have changed, the report includes the old and new values for
each changed field, the ID of the user who made each change, the time at which the
change was made, and the type of change.

You select the tables you want to include in an audit by assigning them to a group,
and refine the audit by selecting columns from the tables that belong to the group. You
can also link audited columns to translations — meaningful values that correspond
to values held in audited tables. For example, a person’s actual name might be the
translation value when an audited table column holds a numeric ID for the person.

AppsAudit is completely integrated with Oracle Applications. It not only uses Oracle
application and database features, but also provides audit and reporting capabilities
that Oracle Audit does not offer. The following table lists major differences between
AppsAudit and Oracle Audit:

AppsAudit Oracle Audit
Displays audit results in an AppsAudit Report. Has no available reports.

Displays translation values for audited fields Has no translation capability.

in reports.

Permits the creation of customized reports Translated data does not exist to be reported
based on translated, audited data. AppsAudit  on. Only audited data is stored; therefore the
includes audited data and current data. current values would need to be derived.

Table continues on the next page
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Chapter 1: About AppsAudit

AppsAudit Oracle Audit

Creates triggers with When clauses on Builds triggers with no conditions, causing
audited fields for optimal performance. excessive overhead during auditing.

Permits users to view audited data through Provides no way to view audited data online.

AppsAudit Online Form.

Permits the migration of audit groups from Has no migration capability.
one Oracle instance to another.

AppsAudit and AppsControl

AppsControl is a Logical Apps application that monitors and regulates changes to
fields in Oracle Applications forms. Its users create rules — one for each form field
— that apply any of three “control types.” These subject field-value changes to increas-
ing degrees of review.

An Audit control type, as its name suggests, tracks field-value changes. The two
others — Reason Code and Approval — do more, but also audit changes to the fields
they govern. To carry out its auditing requirements, AppsControl uses AppsAudit.
Every form field corresponds to a database column; for each form field subject to an
AppsControl rule, AppsAudit monitors the corresponding database column.

As a result, AppsControl creates audit groups in AppsAudit for its own use. Although
you can work with these groups in AppsAudit, there are limits to what you can do.
Specifically, when you create your own audit groups you can add database columns
to them, and you can either enable or disable auditing for each of the columns you
add. Within AppsAudit, you cannot perform either of these tasks directly for groups
created by AppsControl. You can achieve these effects only indirectly by opening
AppsControl and modifying its rules.

For information on using AppsControl, see the AppsControl User’s Guide.

Opening AppsAudit
To open AppsAudit:

1 Select the Logical Apps AppsRules responsibility in the Oracle Applications list.
(Ensure first that the AppsRules responsibility is available to you.)

2 A Logical Apps — AppsRules form appears. In it, click on the AppsAudit tab.
If you close the AppsRules form, you can reopen AppsAudit:

1 In the Logical Apps Navigator, click on the AppsRules option and then on the
Open button. (Or, double-click on the AppsRules option.)

2 Once, again, click on the AppsAudit tab in the AppsRules form.

2 User's Guide: AppsAudit 7.0



Chapter 1: About AppsAudit

Making Selections in AppsAudit

When you click in a list of values box to enter data, AppsAudit presents a list icon to

the right of the box. It looks like an ellipsis:

Translation Table Colurnn

| -

When you click on this icon, AppsAudit opens a window in which you can produce

a filterable list of values that may be entered in the text box.

AC Al
APPLICATION_ID
ARGUMENT_METHOD_CODE

ATTRIBUTE1

ATTRIBUTE10D

ATTRIBUTE11

ATTRIBUTE12

ATTRIBUTE3

ATTRIBUTE14

ATTRIBUTE1S

ATTRIBUTEZ

ATTRIBUTES

ATTRIBUTE4

ATTRIBUTES

ATTRIBUTEG

ATTRIBUTET

ATTRIBUTES

ATTRIBUTES

ATTRIBUTE_CATEGORY

CO_PARAMETER .

(Ens Garee)

To use this window:

1 Click in the Find box and type a string of characters for which AppsAudit should
search. You can use the percent sign (%) to stand for any string of characters.
For example, the string AKD would return all entries that begin with those letters,
while the string %.4KD would return all entries in which those letters appear in
any position. The percent sign alone would return all possible entries.

2 C(lick on the Find button. AppsAudit returns a list of items that match your

search criteria.

3 Scroll through the list and click on the item you want.

Click on the OK button.
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Chapter 2

Defining Audit Groups

To be audited, a table must belong to an audit group, and so an essential step in the
auditing process is to create (or modify) a group. When you start AppsAudit, it opens
by default to the form in which you complete this step.

Creating an audit group involves the following:
¢ Giving the group a name.

e Assigning the group a “state,” which designates whether auditing is requested,
enabled, or disabled.

¢ Selecting the database tables that are to belong to the group. Once you add a
table to a group (and save the addition), it cannot be removed.

* Engaging security by determining the Oracle responsibilities that are allowed to
run audit reports for the group.
* Saving the group.

For a table to belong to a group, its entire schema must be defined as audit-enabled.
Unlike Oracle Audit, AppsAudit performs this setup step automatically as you add
tables to a group.

Note
£~ Be sure the AuditTrail:Activate profile option has been set to Yes.

After a group is defined and saved, you need to select columns for auditing from
each of the group’s tables. This process is competed in a distinct form (and is dis-
cussed in Chapter 3).
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Chapter 2: Defining Audit Groups

Assigning a Group Name and State

To set up an audit group, ensure that the Audit Groups tab is selected. This is the
default when you start AppsAudit:

-

-

AppsForm AppsFlow Mll

LOGIRETCITER  Audit Columns

Application Narne |Lugica| Apps Custom (Eespnnsihility Security |
Group Mame |GL JOURNALS
State |Enah|e Requested '|
Description |Genera| Ledger Journals Schema
Audit
Table Name Application Description Schema  Epabled
|GL7.JE73ATCHES |Genera| Ledger |Jnurna| entry batches |GL A
l |GL_JE_HEADERS |Genera| Ledger |Juurna| entry headers |GL 4

OO0O0dao

l

An Application Name field includes the entry Logical/ Apps Custom. This is the name
of a “container” for the audit groups you create. You cannot change this value. (Other
containers exist for “seeded” audit groups, and you can use Application Name values
as parameters to search for those groups. See “Querying an Audit Group” on page 8.)

Enter the following values in the Audit Groups form:

1

In the Group Name field, type the name you want to assign to the group. This
tield accepts uppercase letters and numerals; it does not accept lowercase letters.

In the State list box, select one of the following entries:

Enable Requested: Auditing is requested but not yet enabled. This is the
default value, and is the appropriate entry for a new audit group.

Enabled: The system can conduct audits on the group. If the State box is set
to Enable Requested, AppsAudit automatically changes the value to Enabled
when you select a Create Audit Objects option from the LogicalApps Ultili-
ties menu. (See “Activating the Audit” on page 15.)

Disable—Interrupt Audit: Auditing for the group is paused, and audit objects,
including audit data, are preserved in shadow tables.

Disable—Prepare for Archive: Auditing for the group is stopped, and cur-
rent data for each row is stored in shadow tables, which can be archived.

Disable—Purge Table: Auditing for the group is stopped, and audit objects,
including audit data, are dropped.

In the Description text box, type a description of the audit group.

User's Guide: AppsAudit 7.0
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Adding Tables to the Audit Group

In each row of the grid in the lower half of the Audit Groups form, use the Table
Name list of values to select a database table you want to include in the audit group.

When you select a table, AppsAudit automatically supplies appropriate values for the
remaining fields and check box in the row:

Application: AppsAudit provides the name of the Oracle Application that stores
data in the selected table. You cannot change this value.

Description: AppsAudit displays a description of the database table. You can
modify the description if you wish.

Schema: AppsAudit supplies the name of the schema (database organizational
structure) of which this table forms a part. You cannot change this value.

Schema Audit Enabled: AppsAudit checks this box if the schema is audit-enabled.
If you select a table whose schema is not audit-enabled, AppsAudit displays a
Decision dialog in which you can select Yes to enable the schema for auditing or
No to leave the schema as it is. If you select No, however, AppsAudit does not
accept the table into the audit group. As a result, the Schema Audit Enabled box
is checked for every table you add to the group.

The Scherma for this Table belongs to "AHL"
does not have Audit Enabled. Would you like to
enable the audit for the "AHL" Schema. This
will enable audit for all tables under the
schema that have audit records defined for
thern.

Setting Security

To specify users who are permitted to run audit reports for the tables in this group:

1

2

3

User's Guide: AppsAudit 7.0

Click on the Responsibility Security button. An Audit Group Responsibilities
form appears:

Yalid Responsibilities

= |@Re|ease Management

| -

-

Close

Select any number of responsibilities (one in each field). To run an audit report, a
user must be assigned one of the responsibilities you’ve selected.

Click on the Close button.
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If you choose not to select responsibilities in the Audit Group Responsibilities form,
any user can run audit reports on the tables in this group.

Note

Z A table can belong to more than one group. If you limit the responsibilities
that have access to a group, and one of its tables exists in other groups, then
the same limits apply to the other groups as well.

Saving the Group

When you have finished setting up the group, save it:

1 Click on File in the Oracle Applications menu bar, then on Save in the File
menu.

2 Asyou save the group, a message informs you that primary keys have been
added, but that you need to requery the group to view the primary keys. Click on
the OK button to clear the message.

Primary keys have been added so
please requery to view them

To requery the group, first clear it from the Audit Groups form — position the cur-
sor in the Group Name field, and then click on Edit in the menu bar, Clear in the
Edit menu, and Record in the submenu that appears. Then use the Find feature (see
the next section) to reload the group you are creating. (AppsAudit displays the pri-
mary keys in the form that’s accessible from the Audit Columns tab; see Chapter 3).

Querying an Audit Group

To find an audit group, use the AppsAudit Find window:

1 Click on View in the menu bar, then on Find in the View menu. Ot click on the
Find button, which is located second from the left in the tool bar and looks like a
flashlight. The following form appears:

Application Mame |
Group Mame || |—
Table Mame |

S B G |

8 User's Guide: AppsAudit 7.0



Chapter 2: Defining Audit Groups

2 From the lists of values, select any combination of the following values:

e Application Name: The name of the application that contains a group you
want to locate. (Remember that in this context, application means a virtual
“container” that holds a selection of audit groups.) All of the groups you cre-
ate belong to a Logical Apps Custom application, but you may have access to
others that contain “seeded” audit groups, which would be configured by
Logical Apps and provided with AppsAudit.

¢  Group Name: The name of the group you want to locate.

e Table Name: The name of a table within a group you want to locate.

3 Click on the Find button.

Depending on the parameters you specify, the search may uncover more than one
group. For example, if you provide only a table name and the table belongs to more
than one group, the search returns all the groups to which the table belongs. In such
a case, ensure that the cursor is positioned in the Group Name field of the Audit Groups
form (this is the default after you use the Find tool) and press the up- or down-arrow
button to move from one group to another.

The Find form also contains a New button. If you click on it rather than the Find
button, any values entered in the Audit Groups form are cleared and you can create a
new group.

User's Guide: AppsAudit 7.0 9
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Chapter 3

Defining Audit Columns and Translation
Data

After you specify the tables that belong to a group, you need to select columns from
each table. For a given column in an audit table, you can also specify a translation
value — a corresponding column in a lookup table. This lookup column would con-
tain meaningful values that match up with values in the audited tables, such as a per-
son’s actual name in place of a numeric identifier.

A table can belong to more than one audit group, and the selection of columns for a
table is identical in all the groups to which it belongs. If you add columns for a table
in one group, the same columns are added for that table in its other groups. If you
add a table to a group, any column selections made earlier in other groups apply in
the new group by default. Translation-value settings configured for a table in one
group apply in all the groups to which the table belongs. Once you add columns for
a table (and save the addition), the columns cannot be deleted.

You select columns and specify translation values in the form available when you
click the Audit Columns tab in AppsAudit. First, though, click on the Audit Groups
tab and ensure the following:

*  You have saved the audit group with which you want to work, and then reloaded
it. (See “Querying an Audit Group” on page 8.)

*  You have selected the table whose columns you want to prepare for auditing. (In
the grid that lists tables, click on the small rectangle to the extreme left of a table
row. Doing so turns the rectangle blue, an indicator that the table is selected.)

User's Guide: AppsAudit 7.0 11
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Selecting Columns

Click on the Audit Columns tab. The following form appears, displaying the names
oup and audit table that you selected in the Audit Groups tab:

AppsForm  AppsFlow
1
Audit Groups ]
Audit Table Marme |GL_JE_BATCHES Group Name |GL JOURNALS Impart Columns
Reporting Key
Primary Translation
~ Calumn Mame Description Key Enabled e Lookup Table Loakup Value
= | [Je_BaTCH_ID [Je Batch 14 ¥ [ W [NoLookup ~| \
|| [bESCRIPTION [Description O [« [NoLookup ~|| \
| [sTaTUS [status C 0 @ [MoLookup - \
\ | oo o | \
I | oo o | \
=Ll | oool \
Translation Table Column Type Audit Table Column
= l | ‘Column v||
| \ |
Al \ |
I \ |
| \ |
Sl |

If the name of the audit group begins with the prefix I.4_AC, it has been created
automatically in support of AppsControl rules. In this case, it lists database columns,
each of which corresponds to an Oracle Applications form field that is subject to an
AppsControl rule. You cannot add columns to those already displayed; the Column
Name LOVs do not accept input and the Import Columns button is inactive.

If, however, the audit group has been created directly in AppsAudit, this form also
displays, at minimum, values for the following columns from the table you selected:

 If the table has never before been included in a group, the form displays values
for the table’s primary-key columns.

* If the table belongs to other groups, the form shows values for the columns
selected in those groups.

You can add columns, one by one, by selecting each in the next available list of
values under Column Name. Alternatively, you can complete these steps to select
audit columns:

1 Click on the Import Columns button. An Audit Columns form appears (as
shown at the top of the next page), listing all of the columns in the table you’ve
selected.

2 C(lick the Include Flag checkbox for each of the columns you want to audit. Or,
click on the Select All button to include all columns. (You can also click on a
selected check box to clear it, or the De-Select All button to clear all check boxes.)
Owing to Oracle Audit limits, you can select a maximum of 248 columns.

3 Click on the Accept button.

12 User's Guide: AppsAudit 7.0



Chapter 3: Defining Audit Columns and Translation Data

© Audit Columns
Colurnn Mame Description Include Flag
= ‘ACCRUALJ}EVﬁCHANGEislGNJ:LAG |Type of reversal (Change Sign or Switch Dr/C O
‘ACCRUAL_REV_EFFECTIVE_DATE |Reversed Jjournal entry effective date O
- |ACCRUAL_REV_FLAG [Reversed journal entry flag m
1 ‘ACCRUALiREviJEiHEADERﬁID |Fleversed journal entry defining column O
‘ACCRUAL_REV_PERIOD_NAME |Reversed journal entry reversal period O
| \ACCRUAL_REV_STATUS [Reversed journal entry status m
‘ACTUALiFLAG |Ea|am:e type (Actual, Budget, or Encumbranc O
‘AT[RIBUTH |Descriplive flexfield segment O
\ATTRIBUTE10 [Descriptive flexfield segment m
= ‘A'I'I'RIBLITEZ |Descriplive flexfield segment O
( selectAl | (DeSelect Al Accept Close

Once columns have been selected and the group has been saved, the columns cannot
be deleted from the group definition. (You can, however, disable auditing for a col-
umn by clearing its Enabled check box; see “Adding to Column Definitions,” below).

For key information to be used, tables must be registered to the Applications. (Oracle
seeds this information for its e-business suite tables. Mappings that use custom data-
base tables should be registered, through the use of Oracle APIs.)

Adding to Column Definitions

Regardless of the method you use to select columns, AppsAudit automatically fills in
a description for each column and selects a No Lookup translation type by default.
(See “Setting Up Translations,” below, for more on translation type selections.)

Moreover, if a column is a primary key, AppsAudit has already selected the Primary
Key check box; you need not alter the default selections for this check box.

For each column, an Enabled check box is selected by default, indicating that the
column will in fact be audited. The behavior of this check box depends on whether
the current audit group supports AppsControl rules:

¢ If so (once again, if the group name begins with the prefix 1.4_A4C_), you cannot
change the setting of this check box directly in AppsAudit. If you click on the
check box, a pop-up message informs you that to disable auditing for the column,
you must disable the corresponding rule in AppsControl. Click on the OK button
in this message to close it.

e If, however, the audit group has been created directly in AppsAudit, you can
clear the check box to prevent the column from being audited. (You may wish to
do this, for example, if you’ve inherited a column from another audit group and
do not wish to audit it in the current group.) Having done this, you can reselect
the check box to restore auditing. In either case, you click on the check box. A
pop-up message requires you to confirm your decision; click on Yes to do so or
No to cancel it. If you select Yes, a second pop-up message informs you that the
change has been made; click on its OK button to close the message.

For each column (regardless of whether the audit group supports AppsControl rules)
select the Reporting Key check box if you want data about fields in the column to

User's Guide: AppsAudit 7.0 13
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appear in reports even if field values have not changed. Clear the check box if you want
data about column fields to appear in reports only for field values that have changed.

Setting Up Translations

If you want audit reports to display actual values from an audited column, select No
Lookup in its Translation Type list of values.

Q Lagical App:

AppsForm  AppsFlow

Audit Groups

Audit Table Mame |(GL_JE_BATCHES Group Mame |GL JOURNALS Import Columns
Reporting Key
Primary Translation
Column Mame Description Key Enabled T Lookup Table Lookup alue
=/ |[sE_paTCH 1D [Je Bateh 1d # [ @ [NoLookup - \
| |[pEScripTION [pescription [ [ @ [NoLookup ~| \
_ |[sTATUS [Status [ [ @ [NoLookup - \
| [creaTED_BY [created By O O @ [TableLoo... ~|[FND_usER (USER_NAME
I | oo oo I \
&l | ool \
Translation Table Calumn Type Audit Table Column
= Jluser_ip [cotumn ~ |creaTED_BY
l | |
{01 | |
Ul | |
\ | |
gl \

i)

If, however, you want audit reports to display a translation value for an audited
column, join it to a corresponding column in a lookup table. (You can do this
regardless of whether the audit group supports AppsControl rules.) Typically, you
would specify a linkage among three columns:

e The first is the column that contains an audited value. In the example illustrated
above, this is CREATED_BY in the GI._JE_BATCHES table.

¢ The second is a lookup-table column that contains an identifying value — the same
value as in the audited table. In the example illustrated above, this is USER_ID in the
FND_USR table.

* The last is a column in the lookup table that contains the translation value. In the
example illustrated above, this is USER_NAME in the FND_USR table.

To create this linkage:
In the Translation Type list of values, select Table Lookup.
In the Lookup Table list of values, select the name of the lookup table you want.

In the Lookup Value list of values, select the name of the lookup-table column
that contains translation values for the audited column.

4 Move to the lower grid and, in the Translation Table Column list of values, select
the lookup-table column that contains the identifying value.

14 User's Guide: AppsAudit 7.0
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5 In the Type list of values, select the value Column.

6 In the Audit Table Column list of values, select once again the column from the
audited table that contains the audited value.

In the lower grid, you can complete as many rows as you like to create a translation
value as complex as you like. The rows have an AND relationship — all must be true
for a value to be returned.

To change translation values (once they’ve been saved), you must delete the existing
values and then save the audit group before selecting new values. If you attempt to
replace old translation values directly with new values, AppsAudit presents a message
stating that you must first delete the old values and save the deletion.

Saving Your Work

Once you’ve finished selecting columns and defining translation values, save the new
configuration: click on File in the menu bar, then on Save in the File menu. Or, click
on the Save icon, located first on the left in the toolbar.

Activating the Audit

To enable AppsAudit to begin auditing the group you have defined, click on
Logical Apps Utilities in the menu bar, then on AppsAudit Create Audit Objects in
the Logical Apps Utilities menu.

At this point, two concurrent programs run:

e An AuditTrail Update Tables program updates any changes made to existing
audit groups and creates new audit objects required by new audit groups.

e An LA AppsAudit Update Audit Objects program optimizes the triggers to
include When clauses for the selected columns.

You must select the AppsAudit Create Audit Objects menu option in the following
circumstances:

*  You have created a new group.
*  You have added a table to an existing group.

*  You have added a column (or changed the setting of the Enabled check box for
a column) in an existing group.

You need not select the AppsAudit Create Audit Objects menu option in the
following circumstances:

* You have added or changed a lookup table or a lookup value.
*  You have added or changed lookup join information.

*  You have changed a description.

User's Guide: AppsAudit 7.0 15
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Reporting

AppsAudit lets you save report definitions and run reports based on translated audit
data. You may create a new report definition or query a saved report definition. You
can also select filter criteria for the report based on ranges of old and new values.
Reports are executed via the concurrent request queue.

Defining Reports

To run reports, click on LogicalApps Ultilities in the menu bar, and then on
AppsAudit Report in the Utilities menu. The following Audit Report form appears:

(=] dit

Report Narme [JOURNAL AUDITS Group Name |GL JOURNALS Table Name
Start Date | End Date | Mum of Days (3 Refresh
User Name| Report Style | Master Detail ™| Debuy Level Display [0's O
User Include Old Yalue Old Yalue Mew “alue Mew Yalue
Table Marne Colurmn Name Column Name In Report Column Type From To From To
= | [6L_JE_BATCHES [UNIQUE_DATE |[Unique Date O [varcharz  ~|

\
) [6L_JE_BATCHES |UNRESERVATION |Unreservation Packi || [Number - \
[6L_JE_BATCHES |USSGL TRANSAC|Ussyl TransactionC [ [varcharz - \

| [6L_JE_HEADERS [CREATED BY [Created By [ [character ~| \
O \

O \

\

| [6L_JE_HEADERS [DESCRIPTION [Description \varchar2  ~|
|6L_JE_HEADERS |JE_BATCH_ID  |Je Batch Id (Number -

~ | |6L_JE_HEADERS [JE_HEADER ID |[Je Header Id 7 Number -
Resubmission Options
{ select Al | | De-Select Al
Type Interval Scheduled ¥
Run Date Fram Run Date To ‘ Reguest 1D

Submit Report
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Audit Report Header

To create a new report definition, begin by completing entries in the header area of

the Audit Report form:

1 In the Report Name box, type a name for the report.

2 Make selections in either or both of the Group Name and Table Name lists of
values. (These fields provide access to groups, and tables within groups, that are
either associated with responsibilities you have been assigned, or not associated
with responsibilities at all.)
¢ If you make a selection in the Group Name field, the Table Name field dis-

plays only tables belonging to the group you’ve chosen. You can select one
of those tables to report only on auditing for it, or you can leave the Table
Name field blank to report on auditing for all the tables in the group.

e If youleave the Group Name field blank, the Table Name field displays
tables belonging to all audit groups to which you have access. Select one of
the tables to report on auditing for it.

3 Specify a span of time the report should cover. Do one of the following:

e Type or select starting and ending dates in the Start Date and End Date
boxes. Use the format DD-MMM-YY HH:MM:SS — for example, 1:30 P.M. on
April 28, 2005 would be rendered as 28-Apr-05 13:30:00. (Note that the Start
Date and End Date boxes default to the current date.)

e Type a value in the Num of Days box. AppsAudit subtracts this value from
the date the report is run and uses the resulting date as the start of a date
range. The end date is the date the report is run.

4 In the User Name list of values, select a user to report only on data changes

made by that user. Or leave the box blank to report on data changes by all users.

In the Report Style list box, determine the format of the report output by select-
ing either of the following:

e  Master Detail presents report information as blocks of data, each of which
lists a table, information about its primary keys, and then a row of data about
each of the audited fields that has changed.

e Delimited File presents report information as records of data changes, each
using a tilde to separate the individual values that make up a record.

In the Debug Level list box, select High or Low. AppsAudit maintains data about
both report generation and the audit “package” — the core generation of audit
data from which a report gathers information. It places this data in a log table,
where it may be reviewed if problems need to be resolved. The High debug-level
value produces more detail and retains the data in the table. The Low value pro-
duces less detail and allows log data to be purged. Typically, select Low. (This
setting does not alter the information presented in an audit report.)

Select the Display IDs check box if you want the report to identify primary keys,
or clear the check box if not.
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Audit Report Detail

Once the header information is in place, click the Refresh button to select tables and
columns for inclusion in the report. In response, AppsAudit fills the grid in the Audit
Report form with entries for all columns selected for auditing:

If you selected a table name as you completed the report header, AppsAudit
displays all the audit columns from that table.

If you selected a group name as you completed the report header, AppsAudit
displays all the audit columns from all the tables of the group.

For each, AppsAudit supplies the Table Name, Column Name, and User Column
Name, and selects an Include in Report check box. In a Column Type list box,
AppsAudit also provides the data type for the column; however, if the report is to
present data from a lookup table, the data type shown here reflects the lookup value.
For instance, if the audited column is VENDOR_ID but a lookup table is to provide
VENDOR_NAME in the report, the data type is given as Character, not Number.

You can refine this automatically generated selection of columns:

Choose the columns you want in the report. For each column, click on the
Include in Report check box to remove the check mark and therefore exclude
the column from the report. Or click on the check box again to reinsert the
check mark and include the column in the report.

Alternatively, click the Select All button to include all the columns or the De-
Select All button to exclude all the columns. Note, however, that you cannot
exclude columns defined as primary keys.

Define ranges of values that filter report entries.

For any column, type entries in the Old Value From and Old Value To boxes to
report only data changes that begin with a value in the range you specify. For
example, if a numeric field contained the value 6 and the data were changed, a
record of that change would nevertheless be excluded from a report if you
specify old-value-from and -to entries of 0 and 5.

Similarly, type entries in the New Value From and New Value To boxes to
report only data changes that end with a value in the range you specify.

Note
Z Filter values for two or more columns have an AND relationship — all must
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be true for the filter to return a result. For example, if you define an old-value
filter for a name column that permits only the name Swzth (if that name is
placed in both the From and To boxes), and an old-value filter for a date col-
umn that permits only a single date (if that date is placed in both the From and
To boxes), then the report would display audited data only for records concern-
ing Smith on the specified date.
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Resubmission Options

You can schedule a report to be run repeatedly. To do so, select values in the block
of the Audit Report form labeled Resubmission Options:

* In the Type list box, select Hours, Days, or Weeks to designate the unit of time
you use to define an interval at which the report is to be rerun. Or, keep the
default selection, None, to prevent the report from being rerun.

* In the Interval box, type a number that expresses the interval at which the report is
to be run. For example, if you type 5 here and select Hours in the Type list box,
the report is resubmitted every five hours.

¢ In the Run Date From and Run Date To boxes, type or select dates and times
that mark the beginning and end of the period in which the report should be run
repeatedly. Again, use the format DD-MMM-YY HH:MM:SS — for example, 1:30
P.M. on April 28, 2005 would be rendered as 25-Apr-05 13:30:00.

AppsAudit fills in these values:

* The Scheduled check box indicates that the reporting cycle you have defined is
being implemented. AppsAudit checks it when you submit the report. Once the
date in the Run Date To box has passed, AppsAudit clears the Scheduled box.

e The Request ID text box displays an identifying number for the most recent
submission of the report. For instance, if a report runs four times per day, this
box would at the end of the day display the fourth request ID.

Saving a Report

When you are done selecting header, detail, and resubmission options, save the
report definition: click on File in the menu bar and then on Save in the File menu.

Submitting and Viewing Reports

20

Once you have defined a report, click on the Submit Report button in the Audit
Report form. When you do, a message similar to the following one indicates that the
report is being generated:

Note the request ID number, then click on the OK button to close the message.

Note

Z If two reports are submitted, the second does not begin until the first has
finished running. This is because audit data is placed in a temporary table
until it is no longer needed for generating the report, then purged; a second
report must wait so that it does not overwrite temporary-table for the first.
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To view the report:

1 Click on View in the Oracle Applications menu bar, then on Requests on the
View menu. The Find Requests form appears:

T My Completed Bequests
T My Reguests In Progress
Al My Requests
~® Specific Request
Request ID 2712977
Mame |
Date Submitted
Date Completed

Status | v|
Phasze | v|
Fequestar |
[TInclude Request Set Stages in Cluery
QOrder By | Request ID -
Select the Number of Day(s) to View: 7
( Submit a New Request.. J ( Clear | I Find )

2 To see your report and its progress, click the My Requests in Progress radio
button and then the Find button. Or click the Specific Reports button, type the
request number for your report in the Request ID field, and click the Find
button.

3 A Requests form shows the status of your request. When it informs you that the
report is completed (you may need to click on the Refresh Data button), click on
the View Output button. The report appears.

( Refresh Data | [ Find Requests )I ( Submit a New Reguest... )I
~ RequestID Mame Parent Phase Status Pararneters
|ZEEEE  |JOURNAL AUDITS (LA Af| [Completed  [Normal [100107, 0, 59966, 20064 =
| | | | | |
| | | | | |
U | | | | |
U | | | | |
U | | | | |
U | | | | |
| | | | | |
| | | | | |
| | | | | | -
( Haold Request [ Wiew Details.. /I ( “iew Output /I
( Cancel Reguest [ Diagnostics J ( Wiew Log... /I
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The form that the report takes depends on the selection you made in the Report
Style list box when you entered header information in the report definition. If you
chose Master Detail, the report looks like this:

a

Date 05-0CT-04 07:21:43 JOURNAL AUDITS Page 1 Of 4
Group Mame GL JOURMALS
Tahle MNawme
Start Date
End Date
Usernawe
1
HNumber of Davs
Date 05-0CT-04 07:21:43 JOURHNAL AUDITS Page 2 Of 4
Table Namwe: GL_JE_EBATCHES
delection Criteria :
Column Hame ¢ld Value From 0ld Value To Hew Value From New Value To

Audit Data @

Frimary Key Value
Je Batch Id 31499
Transaction
User Name Type Time Stamp Column Name 0ld Value New WValues
SNCLAUGHLIN Insert 07-0CT-2004 16:57:15 Nawe JAN-ADJ 07-0CT-2004 JAN-LDJ O7-0CT-2004
16:56:43 16:56:43

If you chose Delimited File, the report looks like this:

Group_Neame~Table Name~Start_Dace~End Dace~Primary Key~Value~DE_Column~DE _Value~Usernawe~Transaction Type~Timestamp~Colum

GL
5L
GL
GL
GL
GL
GL
GL
5L
GL
GL
5L
GL
GL
GL
GL
GL
GL
5L
GL
GL
5L
GL
GL

ar

JOURNAL
JOTRNAL
JOURNAL
JOTURNAL
JOUENAL
JOURNAL
JOTURNAL
JOURNAL
JOTRNAL
JOTURNAL
JOURNAL
JOTRNAL
JOURNAL
JOTURNAL
JOUENAL
JOURNAL
JOTURNAL
JOURNAL
JOTRNAL
JOTURNAL
JOURNAL
JOTRNAL
JOURNAL
JOTURNAL

AATIDN AT

ENTRIES~~~=Je
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Te
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES~
ENTRIES«~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Je
ENTRIES~~~~Je
PHTD TR e Ta

Changes to Audit Setup

Reports based on Audit Groups that have been changed (tables have been added)
need to be refreshed. Use the Refresh button on the Report Submission form to
import automatically any new table columns that were not previously defined on this
report.
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Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Header
Taadar

Id~FEE—ADJ—CONTROLLER~JE_HEADER_ID~33372:SMCLAUGHL IN~Insert~13-0CT-2004
Id~FEB-ADJ-CONTROLLER~JE_HEADER ID~33372~5MCLAUGHLIN~Insert~13-0CT-2004
Id~FEE-ADJ-CONTROLLER~JE HEADER ID~33372~3MCLAUGHLIN~Inserc~13-0CT-2004
Id~FEE-ADJ-CCNTROLLER~JE_HEADER_ID~33372Z~3MCLAUGHLIN~Update~13-0CT-2004
Id~FEB-ADJ-CONTROLLER~JE_HEADER ID~33372~3MCLAUGHLIN~Update~13-0CT-2004
Id~FEE-ADJ-CONTROLLER~JE HEADER ID~33372~5MCLAUGHLIN~Update~13-0CT-2004
Id~FEE-ADJ-CCNTROLLER~JE_HEADER_ID~33372Z~3MCLAUGHLIN~Update~13-0CT-2004
IA~-FEBE-4DJ-CCONTROLLER~JE_HEALDER_ID~33372~3MCLAUGHL IN~Update~14-0CT-2004
Id~FEB-ADJ-CONTROLLER~JE HEADER ID~33372~5MCLAUGHLIN~Update~14-0CT-2004
Ia~FEE-ADJ-CONTROLLER~JE _HEADER_ID~33372~SMCLAUGHL IN~Update~14-0CT-2004
IA~FEE-4DJ-CCONTROLLER~JE_HEADER_ID~3337Z~3MCLAUGHL IN~Update~14-0CT-2004
Id~FEB-ADJ-CONTROLLER~JE_HEADER ID~33372~5MCLAUGHLIN~Update~14-0CT-2004
Id~FEE-ADJ-CONTROLLER~JE HEADER ID~33372~3MCLAUGHLIN~Update~14-0CT-2004

IA~FEE-ADJ-GERMANY~JE_HEADER ID~33363~3MCLAUGHLIN~Insert~12-0CT-2004 09:
Id~FEB-ADJ-GERMANY~JE_HEADER ID~33363~3MCLAUGHLIN~Insert~12-0CT-2004 09:
Id~FEE-ADJ-GERMANY~JE HEADER ID~33363~3MCLAUGHLIN~Insert~12-0CT-2004 09:
IA~FEE-ADJ-GERMANY~JE_HEADER ID~33363~3MCLAUGHLIN~Update~12-0CT-2004 09:
IA~-FEE-4DJ-GERMANY~JE_HEADER ID~33363~SMCLAUGHLIN-Update~12-0CT-2004 09:
Id~FEE-ADJ-GERMANY~JE_HEADER ID~33363~3MCLAUGHLIN~Update~12-0CT-2004 09:
Id~FEE-ADJ-GERMANY~JE HEADER ID~33363~3MCLAUGHLIN~Update~12Z-0CT-2004 09:
IA~FEE-41DJ-GERMANY~JE_HEADER ID~33363~SMCLAUGHLIN~Update~1Z-0CT-z004 09:
Id~FEB-ADJ-GERMANY~JE_HEADER ID~33363~3MCLAUGHLIN~Update~12-0CT-2004 09:

16:
16:
143:18~8et OL )
143:23~Descript
143:23~3et OFf ]
14312 6~Descrip
43:26~3et OL )
:10:06~Descript
:10:06~3et OFf ]
:10:10~Descrip
:10:10~3et Of ]
:10:153~Descript
t10:13~8et Of )
i4Z~Descriptiom
4Z~Name~null~]
14z~Zet Of EBool
:04~Descriptiom
:04~Set Of Bool
:08~Descriptiom
:08~5et Of Boo
:1l~Descriptiom
:11~3et Of Bool

43:18~Descripl
43 : 18~Name~nu

Id~FEE-ADJ~JE_HEADER ID~33362~8M1~Update~12-0CT-2004 06:18:45~Description~ADJUSTHENTS FEI
Id~FEE-ADJ~JE_HEADER_ID~3336Z~3M1~Update~12-0CT-2004 06:18:45~%et Of Books Id~Vision Com

TA-RFR_ATTTF HRANFD TH.232 87 301 TTndaran 19 A0 T_20Nd A8« 10: EA Tasmednk i mne ANTTSETURNTS FF1

If a report is based on an Audit Group that has been changed, and the report
definition has not been refreshed, the report will fail. Simply click the Refresh button
and submit the report again.
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Querying a Report
To find an existing report:

1 Ensure that the Audit Report form is open (page 17).

2 C(lick on View in the menu bar, then on Find in the View menu. The following
form appears:

© Logical Apps AppsAudit Find
Report Mame || |_
Group Narme |
Tahble Name |
Scheduled Reports |Y -
[ cear | [ wew || Fnd

3 Define search parameters:

* Report Name — Type the name of a report or select one from list of avail-
able reports.

¢ Group Name — Type the name of a group or select one from list of avail-
able groups defined on saved reports.

¢ Table Name — Type the name of a table or select one from list of available
tables defined on saved reports.

e Scheduled Reports — Select Y for reports scheduled for regular resubmis-
sion or N for unscheduled reports.

4 Click on the Find button. AppsAudit populates the Audit Report from with
definition data for the report you specified.

Alternatively, click on the New button to clear the Audit Report from for the crea-
tion of a new report definition. Or click on the Clear button to clear selections
you’ve made in the Find form.
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AppsAudit Online Form

An AppsAudit Online form can display audit data about a record currently selected
in an Oracle Applications form. To use it, complete two tasks:

Create an AppsForm rule that establishes a navigation link from the form you are
auditing to the online audit form.

Add an AppsAudit Online function to the menu structure of the responsibility
that is to have access to the online audit form.

To complete the process, you need the following information:

User's Guide: AppsAudit 7.0

The name of the form you are auditing and the application in which it runs.

This information is available in the Form Functions form of the System Admin-
istrator responsibility: the form name you want is in the Function field (no mat-
ter what tab you’ve selected) and the application name is in the Application field
on the Form tab. For example, if you query on the Enter Vendor user form name
(in the Form field, Form tab), you obtain the values APXVDMVD in the Function
field and Payables in the Application field.

The name of the responsibility that both has access to the application and is assigned
to a user who needs to view the online audit form.

This information is available in the Responsibilities form of the System Adminis-
trator responsibility. You can use the application value (for example, Payables) to
query on the Application field and obtain all the responsibilities with access to

that application. (One of those responsibilities, for instance, is Payables Manager.)
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The name of the menu associated with the responsibility. When the responsibil-
ity is loaded in the Responsibilities form, the menu name is displayed in the Menu
tield on that form — for example, AP_NAVIGATE_GUI12 for Payables Manager.

The name of the database table that supports the form, and its primary keys. One
way to obtain the table name is to open the form in question, query a record, select
Record History from the Help tool, and view the table name in the About This
Record dialog. If the dialog provides the name of a database view (if the name ends
in _1), you'll need to obtain the database name elsewhere. For the APXVDMVD
form, the database table is PO_VENDORS and the primary key is VENDOR_ID.

For each primary key, the name of the corresponding block and field in the form
being audited. One way to obtain this information is to open the form in ques-

tion and select the Diagnostics/Examine option of the Help menu. For example
the block and field for the VENDOR_ID primary key column is VNDR.VENDOR_ID.

The application ID for the application that runs the audited form. (For example,
the ID for the Payables application is 201.) To find the value, run this SQL query:

SELECT APPLICATION

Creating the AppsForm Rule

_ID FROM FND TABLES WHERE TABLE NAME = 'table name'

Open AppsForm to create a link from the audited form to the online audit form.
(For detailed information on using AppsForm, see the AppsForm User’s Gmde)

QRN AppsFlow  AppsAudit
Subscribers
Rule Name Description Debug  Active Euxist
[+ ll()nline Audit |Imp|emems the Appsfudit Online Audit forr [ v O
A [ O O m
= | | O O O
Rule El
Seq Element Name Form Name User Form Mame Event Block Mame  Field Name Debug Active
2 [0 (ender Online AJAPXVDMVD  [Enter Vendor When New Form | 0
’7 Form Name |APXVDMYD Element Description ‘Vender Online Audit Event When New Form
“ P Block Mame Field Narme
r Security .MMM Messages Default Yalues  List Of Values  Field Aftributes SaL AppsFlow
’7 Menus
Appsrules Disable
Description ’7 Seguence Label Ta Function Parameters Icon Name  Special Menu  Aciive
2 llTnnIs1[I ~ [Wendor Online Audit Appsudit Online [P_TABLE_NAME=PO_VEND! | O [

\ O O O

S) I

‘ O O O

Zooms

From Elock

To Function

Parameters

Active

"4

O

O

Dane
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After entering a name and description for the rule, enter the following in the Rule
Elements block:

* Sequence: Enter a number that reflects the order in which you want this element
to be performed with respect to any other elements.

* Element Name: Type a name for the rule element.

* Form Name: From the list of values, select the name of the form you are audit-
ing — for example, APXVDMVD if you are auditing the Enter Vendor form.

¢ User Form Name: Accept the value supplied by AppsForm.
e Event: Select the value When New Form.

Once these values are selected, click on the Details button and, in the Business Rule
Details form, click on the Navigation tab. Then enter these values:

* Sequence: Select a sequence number with a Tools prefix to place the link on the
Tools menu. (Select a high value to avoid the possibility of overwriting existing
Tools-menu options.)

* Label: Type a name for the link. This name will appear as an option on the Tools
menu.

* To Function: Select the value AppsAudit Online from the list of values.

*  Parameters: Supply the name of the database table that supports the audited form;
the names of its primary key columns and, for each, the corresponding block and
field in the audited form; and the application ID for the application that runs the
audited form. Optionally, specify a number of days of audited data to display, or
select columns for display. See the following discussion for more on these values.

Parameter Values
When you select AppsAudit Online as the To Function, AppsForm automatically
presents the following template in the Parameters field:

P TABLE NAME=<AUDIT TABLENAME>
P PRIMARY KEYS=!*!<KEY COLUMN1>=#<BLOCK.FIELD1>#!~!<KEY COLUMN2>=
#<BLOCK.FIELD2>#!~!!*! P APPLICATION ID=<APPLICATION_ ID>

If the table has one primary key, delete this block from the template:
<KEY COLUMN2>=#<BLOCK.FIELD2>#!~!

If the table has two primary keys, leave the template as it is; if the table has three or
more primary keys, add in a new block for each key. In any case, replace the place-
holder names — the text enclosed by angle brackets (and the angle brackets them-
selves) — with appropriate values.

For example, the parameter statement for the Enter Vendors form (whose appropri-
ate values are discussed on pages 25-26) would be:

P TABLE NAME=PO VENDORS P _PRIMARY KEYS=!*!VENDOR ID=
#VNDR.VENDOR ID#!~!!*! P APPLICATION ID=201
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If the primary key value is of the varchar data type or includes spaces, enclose the
entire primary-key value in double quotation marks and the block and field name
value in an additional pair of single quotation marks, as shown:

P TABLE NAME=<Audit Tablename> P PRIMARY KEYS="!*!<Primary Key
Name>='#<Block.Field Name>#'!~!!*!" P APPLICATION ID=<Application ID>

You can add parameters that specify the number of days worth of audit data to pre-
sent and select columns about which to display data. These optional parameters take
the following form, and follow the application ID parameter:

P AUDIT COLUMNS=!*!<Audit Column>!*!<Audit Column> P_NUM OF DAYS=
<Number of days>

Adding Online Audit to a Responsibility

To add the AppsAudit Online function to the menu structure of the responsibility
that is to have access to the online audit form, complete these steps:

1 Determine the responsibility whose menu structure is to be altered. Assuming you
know the name of the application that runs the form that is to be audited:

¢ Open the Responsibilities form in the System Administrator responsibility.

¢ Query on the Application field — press F11, type the application name in
the Application field, and press Ctrl+F11.

¢ The form loads all the responsibilities from which the application can be run.
Press the up- or down-arrow button to scroll through them.

* Stop at the appropriate responsibility — one assigned to a user (or users)
who need to view the online audit form.

2 In the Responsibilities form, note the name of the menu associated with the
responsibility you’ve selected — for example, AP_NAVIGATE_GUI12 for the
Payables Manager responsibility.

Responsibility Name |Payahles Manager

Effective Dates ——
Application |Payahles From [01-JAN-1951
Responsibility Key |PAYABLES_MANAGER To

Description |

Available From Data Group
F Oracle Applications ‘ ( Marne ‘Slandard

© Oracle Self Service Web Applications

Applicati Payahles
" Oracle Mobile Applications [FAliEaln ‘ W

Web Host Name ‘
Web Agent Name ‘

R G
(YA NAVIGATE GLUITZ [ { ! ';::]E (Al Ropors

Application ‘Payahles

Menu Exclusions Excluded ltems Securing Attributes

~ Type Marme Description
||Fun|:1inn '”
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3 Close the Responsibilities form and open the Menus form. Query for the menu
whose name you’ve just identified:

Menu |[AP_NAVIGATE_GUI2 [ viewTree.. |
User Menu Name |AP_NAVIGATE_GUI2
Menu Type ‘Slandard
Description ‘AF Navigate Menu
~ Beq Prompt Submenu Function Description Grant
o Waorkflow [AP_WORKFLOW_GUIZ| [workflow s
[0 [other [FND_OTHER 4.0 [ |other 2
N [aZn_PR_PAYABLES | [Accounts Payahle Processes in G ¥
Tz [aP_PO_VIEW_PURCHA!| | v
|13 | |Bank Account Access: S| v
e [ap_Pos_nv | | rd
[ |15 ‘Funds Availahle| |Fum:|s Available Inquiry|Funds Available Inquiry vt o
[ |115 ‘ | |AppsAcce$ Activate Re| |
[ |215 ‘ | |AppanntrnI Change Re| v
Jzo | | [Bppsaudit Online | Che

4 Add a row to the grid (click on File in the menu bar, then on New in the File
menu). Add a sequence number in the Seq field, and select AppsAudit Online in
the Function list of values. (Do not enter a value for Prompt or Submenu.)

5 Click on File in the menu bar, then on Save in the File menu.

Viewing the Online Audit

Ensure that the table supporting the form for which you’ve created the link is
included in an audit group. Then navigate to the form and click on the Tools menu.
It should include the link you’ve created:

% Oracle Applications - ¥ision

File Edit View Folder Window Help

ﬁ % o[ @ = Check Expired Values

Wiew EFT Details
Wl wendor Online Audit

Supplier.Name |3M Health Care Supplier Number |5037

Alternate Mame |

Taxpayer ID Tax Registration Number
Inactive On | ﬁ ]

Bank Acc..  EDI lmoi.. Withh . TaxR. [_*]

DR L@ P57

General  Classification Accounting  Control

LGB0 Net (terms date + 30 |— Invaice Currency

Pay Group |Standard Payment Currency

Payment Priority (99

Terms Date Basis |Inv0ice v| [ Always Take Discount
Pay Date Basis |Discount '| [/ Exclude Freight From Discount
Payment Method |Check v| [ Allow Interest Invaices
[ Pay Alone

' Sites I
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Click on the link to open the AppsAudit Online form:

-

-

|

Column Marme Column value Time Stamp User Mame Transaction Typa
1 20JuL01 [24JUN 2005 14:03:54 [ACORELLI [update
| |Last update Login [1072926 [24JUN2005 14:03:54 [ACORELLI [update
| |Last updated By [1001701 24 JUN2005 14:03:54 |ACORELLI update
| Wendor Name Alt | [24JUN-2005 14:03:54 [ACORELLI [update

Primary Key Mame Primary Key Yalue Find

Jivendor 1 783

Column Mame |

Colurnn Yalue |

| |
I I Mumber of Days |3|]

Refresh

Primary key values include the following:

Primary Key Name — Primary key of table being audited.

Primary Key Value — Value of primary key being audited, or translated value if
defined.

Detailed audited data values include the following:

Column Name — Column being audited.
Column Value — Value of column being audited.
Time Stamp — Time data was audited.

User Name — User that changed the data.

Transaction Type — Whether a new value updates a previously entered value or
fills a field that had previously been empty.

Find criteria include the following:

Column Name —Search for audited data by column name. Wild cards (%) may
be used. For example, to show only the Description column, enter Desc% in the
Column Name and click Refresh.

Column Value —Search for audited data by column value. Wild cards (%) may
be used. For example, to show audited data where value is like INV, enter INV%
in the Column Name and click Refresh.

Number of Days — The value 1 indicates audited data with the current date for
an audit timestamp; the value 2 indicates audited data from the current day and
the previous day; and so on. The default number is 30.

Note
Z Translated values are displayed if they have been defined in the Audit Setup
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Security

The online form opens only if the user is currently in the responsibility to which the
table has been restricted. The following message appears if the current responsibility
does not have access to view audited data for the table:

B Mote

S

‘ Audit Group Responsibility Invalid

Note

Z If a table exists in more than one group, all restricted responsibilities are
considered. The online audit form shows data only if the user is currently in
one of the restricted responsibilities.
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Audit Migration

Once you have created audit groups for an instance of Oracle Applications, you can
“migrate” them — copy an audit group, the auditing instructions for an individual
table within a group, or a report directly to another Oracle Applications instance.
You can also export groups and tables to, or import them from, XML files.

Preparing for Migration

Before you can migrate audit groups and tables, you need to specify connection
information in all the environments to and from which you plan to transmit data.
You need to know the host name, instance SID, and database instance port for each
environment. This information is found in the TNSNAMES.ora file, which is located in
ORACLE_HOME /network /admin.

Once you’ve gathered this information, use the Logical Apps Migration Ultility to
perform the connectivity configuration:

1 With AppsAudit open (see page 2), click on LogicalApps Ultilities in the menu
bar, then on Migration Setup in the Ultilities menu. A Migration Utility form
appears (as shown at the top of the next page).

Ensure that the Setup Host Names tab is selected.

In the Host Name column enter the host name (machine name) for each of the
machines hosting the database and involved in audit migration.
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ration UMility [-0-0-

Setup Instances

~ Host Name Description
= I|newpurt.whq.logicalapps.cnm |Dev
|cypres.whq.lngicalapps.cnm |QA

-

4 In the Description column, you may enter a description for each host name.
(This step is optional.)

5 Click on the Setup Instances tab. The following form appears:

Migy

Setup Host Names

Host Name Instance Port Mumber  User Name Password
=1 l|newport.whq.logicalapps.cum |visdev |1525 |apps

-

‘ssssasssssssss
. |cypress.whq.Iogicalapps.cum |visdh |1521 |apps "’”‘*’”"*
' \

\

\

|

Connect String [idhc:nracle:thin:@newpnn.whq.lngicalapps.cnm:152§:visdev

6 In the Host Name column, select the host name for each of the machines from
the list of values. (The entries are those defined in the Setup Host Names tab).

7 In the Instance and Port Name columns, type the instance name and port num-
ber that corresponds to each host name.

8 Under User Name, type the value apps for each entry. Under Password, enter the
password for the apps user.

9 C(lick on File in the menu bar and Save in the File menu. When the configuration
is saved, the system automatically generates and displays a connection string.

10 Close the Migration Utility: Click on the X symbol in the upper right corner of
the form.
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Dependencies

The following conditions apply to migration, export, and import operations:

For a table or a report to be migrated, its audit group must already exist on the
destination instance.

For an instance-to-instance online migration, the ID of the person who created
an audit group, table, or report in the source instance must exist in the destina-
tion instance. (However, the user’s status on the destination instance may be active
or inactive. Audit migration does not validate whether the user is active.)

For an XML file import, the user ID of the person who created an audit group,
table, or report need #of exist in the destination instance. The CREATED_BY and
LAST_UPDATED_BY fields are updated with the ID of the person who performs
the file import.

A log file gathers information about a migration, export, or import operation. If
an operation fails and you are unable to determine why, rerun the operation with
the debug level changed from low to high and evaluate the log data.

Commonly, problems with migration result from missing translations. In such
cases, the audit log shows errors as INVALID. For instance, if a table or a respon-
sibility does not exist in the destination, a migration error occurs.

Migrating or Exporting a Group or Table

To migrate an audit group, or a table from the group, to another instance, or to
export a group or table to an XML file, complete the following steps:

1
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With AppsAudit open (page 2), click on LogicalApps Ultilities in the menu bar,
then on Migrate Rules in the Utilities menu. The Migrate Audit Rules form
appears:

Action Type | Migrate to Another Instance v|
— Source Audit Rule Destination Instance
Audit Group| |— Inatance|
Audit Table | Apps Pagswd |
—— Debug/File Options
Debug LeveI|an -
File name|
Directory |a’tmp
( Cancel J ( Clear )I ( Migrate J
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In the Action Type list box, select the operation you want to perform:

e Migrate to Another Instance (the default) if you want to migrate a group or
table.

¢ Export to File if you want to export a group or table to an XML file.
In the Audit Group list of values, select the group you want to migrate or export.

If a group has been opened in the AppsAudit Audit Groups form, that group
appears here by default when you open the Migrate form.

If you want to migrate or export the group you selected in step 3, leave the Audit
Table list of values blank. If you want to migrate or export a table from that
group, select the table in the Audit Table list of values.

If a group has been opened in the AppsAudit Audit Groups form and the cursor
is focused on a table listed in its Table Name column, that table appears here by
default when you open the Migrate form.

If you are performing a migration, make entries in the Destination Instance
block:

* In the Instance list of values, select a destination instance for the migration.

e In the Apps Passwd text box, type the apps password for the destination in-
stance if you are prompted to do so. (This prompt appears if the XXLAAPPS:
Enable for Migration Security profile option is set to Yes on the source
instance. If the option is set to No, the prompt does not appear and a pass-
word need not be entered.)

If you are performing a file export, fields in the Destination Instance block do
not apply and do not accept input.

In the Debug Level list box, select a level of detail for error reporting to a log.
Ordinarily, select Low; select High instead if you need to uncover the cause of a
failed migration or export.

In the Directory text box, type the path that designates a temporary staging file
location for XML files to be generated and, in the case of migration, copied to
the destination instance.

Click on a button that launches the process. Its label varies depending on the
selection you made in step 2: Migrate if you chose Migrate to Another Instance
or Export if you chose Export to File.

Review several messages:

* Depending on the parameters you have specified, the system may launch one
or two concurrent programs to implement the migration or export. For each
concurrent program, a message provides an ID number. Click on the OK
button in each to clear each message.

e If you have performed a file export, the system may create one or two files
(again depending on the parameters you have specified). AppsAudit generates
the name for these files, and a message similar to the following one displays
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the names of the files you have generated. In each file name, the term xwlout
designates XML output, a number (22109 in this example) serves as a unique
identifier for an export operation, the term axdit identifies the Logical Apps
component involved in the export operation, and a last phrase (GLJOURNALS
in this example) identifies the audit group (or group and table, if appropriate)
that is being exported.

After the concurrent programs cormplete the
Audit Definition will be exported to the

files Ampfernlout22109_audit_GLIOURNALS and
ArmpAomlout22109_audit_ GLIOURMALS_LAAD

Make a note of file names and locations, and click the OK button to clear the
message.

Finally, a dialog prompts you to perform another migration. Click Yes to do
so or No to close the Migration form.

Migrating or Exporting an Audit Report

Follow a similar process to migrate a report or export it to an XML file:

1

With AppsAudit open (page 2), open the Audit Reports form (page 17). Click on
Actions in the menu bar, then on Migrate Report Definitions in the Actions
menu. The Migrate Audit Reports Definitions form appears:

5 - higration Uitility

Definitions

Action Type | Migrate to Another Instance v|

Source Report Definition Destination

Report Mame || |— In51ance|
Apps F'asswd|

Copy Options Debug/File Options
Type A Debug LeveI|Low -
Mew Report Fil name|
Final Rule Directory |a’tmp

( Cancel J ( Clear ) ( Migrate J

2 In the Action Type list box, select the operation you want to perform:

User's Guide: AppsAudit 7.0

Migrate to Another Instance (the default) if you want to migrate a report.
Export to File if you want to export a report to an XML file.

Copy within the Same Instance if you want to copy the report under a new
or modified name on the source instance.
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In the Report Name list of values, select the report you want to migrate or export.

If a report has been opened in the Audit Reports form, that report appears here
by default when you open the Migrate Reports form.

If you are performing a migration, make entries in the Destination block:
e In the Instance list of values, select a destination instance for the migration.

* In the Apps Passwd text box, type the apps password for the destination in-
stance if you are prompted to do so. (This prompt appears if the XXLAAPPS:
Enable for Migration Security profile option is set to Yes on the source
instance. If the option is set to No, the prompt does not appear and a pass-
word need not be entered.)

If you are performing a file export or copying a report to the source instance,
tields in the Destination block do not apply and do not accept input.

If you are copying the report to the source instance, make entries in the Copy
Options block:

* In the Type list box, select Copy as a New Report if you want to assign a
completely new name to the copy, or select Prefix or Suffix if you want to
assign a name to the copy that consists of the original report name with text
added at the beginning or end.

* In the second box (labeled New Report Name, Prefix, or Suffix, depending
on the selection you made in the Type list box), type the text you want to use
as a new report name or as a prefix or suffix to the existing name.

e The Final Rule box does not accept input.

If you are performing a migration or a file export, fields in the Copy Options
block do not apply and do not accept input.

In the Debug Level list box, select a level of detail for error reporting to a log.
Otrdinarily, select Low; select High instead if you need to uncover the cause of a
failed migration or export.

In the Directory text box, type the path that designates a temporary staging file
location for XML files to be generated and, in the case of migration, copied to
the destination instance.

Click on a button that launches the process. Its label varies depending on the
selection you made in step 2: Migrate if you chose Migrate to Another Instance,
Export if you chose Export to File, or Copy if you chose Copy within the same
Instance.

Review several messages:

¢ The system launches a concurrent program to implement the migration,
export, or copy. The first message provides an ID number. Click on the OK
button to clear the message.

e If you have performed a file export, a message similar to the following one
displays the name of the export file you have generated. In the file name, the
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term xzzlont designates XML output, a number (22115 in this example) serves
as a unique identifier for an export operation, the term reports identifies the
Logical Apps component involved in the export operation, and a last phrase
(JOURNALAUDITS in this example) gives the report name.

After the concurrent program completes the
Audit Reports Header will be exported to the

file Armnpfomlout22115_reports_
JOURNALAUDITS

Make a note of file name and location, and click the OK button to clear the
message.

* Finally, a dialog prompts you to perform another migration. Click Yes to do
so or No to close the Migration form.

Importing a Group, Table, or Report File

To import an XML file containing any of the audit components — a group, a table,
ot a report — complete these steps. Remember that in some cases an export opera-
tion prepares more than one file, and in such cases you would need to import all of
the files prepared in an export.

1 Transmit exported files via FTP to the destination OS for import.

2 With AppsAudit open (page 2), click on Logical Apps Utilities in the menu bar,
then on Import from File in the Utilities menu. An Import From File form

appears:

Import from File

Directory |ftmp
File Mame |xm|out221UQ_audit_GLJUURNALS

Debuy Level |Luw -

( Cancel )I ( Clear ) ( Import J

3 In the Directory box, type the path to the folder that contains the import file or
files.
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4 In the File Name box, type the name of a file you want to import. This would be
a name displayed by a message at the culmination of a file export (pages 37 and
39).

5 Select a value for Debug Level. Ordinarily, select Low; select High instead if you
need to uncover the cause of a failed import.

6 Click on the Import button. A concurrent request message displays the ID
number of the concurrent program that implements the import. Click on the OK
button to clear the message.

7 If you need to import more than one file, repeat this process as necessary.
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Determining Tables to Audit

The first step in auditing data is to determine the tables where your data resides. To
do this:

1 Navigate to the form that contains data you want to audit. For example, assume
you want to audit the Days Early, Days Late, and Receipt Routing fields in the
Receiving Options form:

19 Optior

Receipt Date Miscellaneous
Action
Over Receipt Control

g
Enforce Ship-To

Receipt Number Options

Action Type Hext Receipt Number

Auomatic < WNumerie W

13 3901-000-1410-0000-000
#(aile| Operations-Balance SheetInventory Material Value-No Sub Ac

2 Seclect Help from the menu bar, then Record History from the Help menu. The
About This Record window appears.
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3 Note the name of the table or view that supports the form. Usually a view has
_I7at the end, as in this example.

Because a view cannot be audited, you will need to perform additional research if the
form fields you are trying to audit are based on a view. At this point, you may need
to work with someone in your organization who is familiar with describing views.

In this example, additional research led to RCV_PARAMETERS, the name of the table
to audit.
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Auditing Prerequisites

A table being audited must have a unique primary key. In some cases, the primary
key Oracle has registered for the table is not unique and can be changed. Changing
primary key values after data has been audited will cause data integrity issues.

Verify Primary Key Is Unique

The easiest way to verify whether a primary key is unique is to check the first unique
index that has been set up for that table. In most cases, this will be the same as the
primary key. For instance, the following query shows a unique index used for a table.

select fc.column name
from fnd columns fc,
fnd index columns fic,
fnd indexes £
where fic.column id = fc.column id
and fic.index id = f.index id
and f.index name like '3Ul%'

and f.table id = (select table id
from fnd tables
where table name = 'AR APPROVAL USER LIMITS')
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This query returns five columns that make up a unique key:

COLUMN NAME
CURRENCY CODE
USER ID
DOCUMENT TYPE
REASON_CODE

The primary key for AR_APPROVAL_USER_LIMITS is only defined as USER_ID.

If the other columns are truly part of the primary key, then they should not be
changeable and in the form. You can change these values. To solve that problem,
you may create a rule in AppsForm that does not allow the five columns that make
up the new primary key to be changed. Use Oracle APIs to register the additional
tields as primary keys.
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Support

From on-site support to remote phone and web support, the Logical Apps team of
experienced professionals provides the help and information you need to ensure
quick and effective implementation. The Logical Apps team includes a Technical
Support Representative, an Account Manager, and a Logical Apps staff consisting of
consultants and support specialists.

Feedback

Thank you for using Logical Apps AppsAudit. We value your comments and
feedback. Mail your comments to the following address, or call us directly at (949)
453-9101.

Logical Apps

Attn: Documentation Management
15420 Laguna Canyon Road

Suite 150

Irvine, CA 92618

U.S.A.

Or send email to support@logicalapps.com.
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